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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)

mailto: solutions@rossvideo.com
mailto: dross@rossvideo.com
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Welcome
This is the Installation Guide for Ross Video’s Panasonic Camera Control System.

The Panasonic Camera Control System enables you to adjust lens iris, camera paint (shading), and all camera menu 
settings for supported Panasonic cameras.

The Panasonic Camera Control System can be set up as a standalone camera control system, or be integrated with a 
Ross Robotics robotic camera system.

This Installation Guide describes how to install and configure the Panasonic Camera Control System as a 
standalone camera control system.

Tip: If you set up a standalone system, and later purchase Ross Robotics, you can reconfigure the Panasonic 
Camera Control System to integrate it with your Robotics system.

For information about how to use the Panasonic Camera Control System, see the Panasonic Camera Control 
System User Guide (8351DR-009-xx).

Documentation Conventions

Text Format Conventions

Special text formats are used in this Installation Guide to identify parts of the user interface, text that a user must 
enter, or a sequence of menus and submenus that must be followed to reach a particular command.

Text Format Meaning

Bold text Bold text is used to identify a user interface element such as 
a dialog box, menu item, or button.

For example:

In the Display Name box, type a name for the node.

Courier text Courier text is used to identify text that a user must type.

For example:

In the address bar, type localhost and press Enter.

Italic text Italic text is used to identify the titles of referenced guides, 
manuals, or documents.

For example:

For more information, see the Panasonic Camera Control 
System User Guide (8351DR-009-xx).

> Menu arrows are used in procedures to identify a sequence 
of menu items that you must follow. 

For example, if a step reads “File > New,” you would tap the 
File menu and then tap New.



1–2 • Welcome Panasonic Camera Control System Installation Guide

User Interface Conventions

You can interact with the Panasonic Camera Control System using a touch screen and/or a keyboard and mouse. 
The instructions in this Installation Guide describe how to interact with the Camera Control Panel using a touch 
screen. The following table provides equivalent actions for using a keyboard and mouse.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest 
telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service 
and technical support is provided directly by Ross Video personnel. During business hours (Eastern time), technical 
support personnel are available by telephone any time. After hours and on weekends, a direct emergency technical 
support phone line is available. If the technical support person who is on call does not answer this line immediately, 
a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to 
react to any problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886

• After Hours Emergency: (+1) 613-349-0006

• E-mail: techsupport@rossvideo.com

• Website: http://www.rossvideo.com

Instruction Touch Screen Keyboard and Mouse

tap Tap the object briefly. Click the object.

Click refers to pressing the left 
mouse button briefly.

Right-click refers to pressing 
the right mouse button briefly.

touch and hold Touch the object and hold your 
finger on it until a circle 
appears, and then release it.

Right-click and hold your 
finger on the mouse button 
until the expected action 
occurs.

drag Touch the object, hold your 
finger on it, and drag your 
finger on the screen to move 
the object.

Click and drag the object.

mailto:techsupport@rossvideo.com
http://www.rossvideo.com
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System Overview and Planning
This section provides information about the Panasonic Camera Control System that can help you plan your 
installation. It contains the following topics:

• “System Overview” on page 2–1

• “Planning the Workstation Components” on page 2–2

• “Planning the Studio and Network Components” on page 2–3

• “Hardware and Software Checklist” on page 2–6

System Overview

The Panasonic Camera Control System enables you to adjust lens iris, camera paint (shading), and all camera menu 
settings for supported Panasonic cameras. It can be set up as a standalone camera control system, or integrated with 
a Ross Robotics robotic camera system.

This Installation Guide describes how to install and configure the Panasonic Camera Control System as a 
standalone camera control system.

This section lists the components of the system, and includes a system architecture diagram.

Workstation Components

The Panasonic Camera Control System includes one or more camera control workstations. Each workstation can 
control all cameras. Each workstation consists of the following:

• A Camera Control Computer, monitor, keyboard, and mouse.

• A Camera Video Monitor. This monitor (not included) displays video from the camera being controlled, so you 
can see on-screen menus and monitor the effect of adjustments as you make them.

• A Camera Paint Box (Optional). The Camera Paint Box features physical knobs for adjusting iris and paint 
controls (gains and pedestals). These settings can also be controlled through the Camera Control Panel.

For more detailed information about the workstation components, see “Planning the Workstation Components” 
on page 2–2.

Studio and Network Components

Studio and network components include the following:

• Network Switch. The system can use a dedicated network switch, or use an existing LAN.

• Panasonic cameras. The system can control iris and paint functions on select Panasonic cameras.

• Serial to Ethernet Converter. These units convert RS-422 signal from the camera to Ethernet communication.

• Proxy server computer. In systems with multiple camera control workstations, the proxy server communicates 
with the cameras. All camera control requests from camera control computers are handled by the proxy server.

For more detailed information about the studio and network components, see “Planning the Studio and Network 
Components” on page 2–3.
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System Architecture Diagram

Figure 2.1 shows the architecture of a Panasonic Camera Control System that includes six cameras in two studios. 
There are two camera control workstations. Each workstation includes an optional Camera Paint Box. Each studio 
has a serial-to-Ethernet converter (Comtrol unit) that can host up to four cameras. The Comtrol unit connects to the 
Ethernet network, and eliminates the need to run individual serial cables from each camera to the proxy server in 
the rack room.

Figure 2.1  - Architecture of a Standalone Panasonic Camera Control System (an example)

Planning the Workstation Components

This section describes the components of a camera control workstation, to help you plan your installation.

The main topics in this section are as follows:

• “Camera Control Computer and Accessories” on page 2–3

• “Camera Video Monitor” on page 2–3

• “Camera Paint Box (optional)” on page 2–3
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Camera Control Computer and Accessories

The Camera Control Computer runs DashBoard, which is a versatile control and monitoring interface for many 
Ross Video and openGear Partner devices. Through DashBoard you can access the Camera Control Panel, which is 
the camera control interface featuring camera iris and paint (shading) controls. The Camera Control Panel also 
provides access to on-screen camera configuration menus.

You need one Camera Control Computer running DashBoard at each camera control workstation. DashBoard is 
free, but the Panasonic Camera Control System is a licensed application. You require one license for each camera 
control workstation.

You can purchase your Camera Control Computer(s) from Ross Video. Alternatively, you can use any computer 
that meets the Windows system requirements for installing DashBoard. To view the DashBoard system 
requirements, download the DashBoard User Guide at 
http://www.rossvideo.com/control-systems/dashboard/index.html.

If your system includes multiple camera control workstations, the camera control computers are set up in a 
primary-secondary topology. On each camera control computer, DashBoard is configured to be a secondary 
instance. On an additional proxy server computer, DashBoard is configured to be the primary instance.

Camera Video Monitor

The camera video monitor can display video from the camera being controlled, so you can see on-screen menus and 
monitor the effect of adjustments as you make them. The camera video monitor is usually a carefully calibrated 
reference monitor. Sometimes two monitors are used, to compare video output of two cameras side-by-side. Video 
routing equipment is required to direct the desired video feed to the monitor(s).

Note: Camera video monitors and routing equipment operate independent of the Camera Control System. The 
Camera Control Panel and Camera Paint Box do not select video to be displayed on camera video monitors.

When adjusting paint controls, technicians often use a waveform/vectorscope to fine-tune the properties of the 
camera output. The Camera Control Panel enables you to access the camera’s color bars output for calibration 
purposes.

Camera video monitors, video routing equipment, and waveforms/vectorscopes are not included as part of the 
Panasonic Camera Control System.

Camera Paint Box (optional)

The Camera Paint Box is an optional accessory that features physical knobs for adjusting iris and paint controls 
(gains and pedestals). These settings can also be controlled through the Camera Control Panel.

Each camera control workstation may or may not include a Camera Paint Box.

The Camera Paint Box is connected to the camera control computer by a USB cable. The Camera Paint Box is 
designed to occupy 1RU in a standard 19” component rack.

Planning the Studio and Network Components

This section describes the studio and network components of a camera control workstation, to help you plan your 
installation.

The main topics in this section are as follows:

• “Cameras” on page 2–4

• “Serial to Ethernet Converter(s)” on page 2–4

• “Proxy Server Computer” on page 2–5

• “Network Configuration” on page 2–5

http://www.rossvideo.com/control-systems/dashboard/index.html
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Cameras

The Panasonic Camera Control System works with Panasonic AK-HC1500 video cameras, and may work with 
other Panasonic cameras that communicate over RS-422 serial protocol. For information about which Panasonic 
cameras are supported, contact Ross Video.

Serial to Ethernet Converter(s)

Supported Panasonic cameras communicate over RS-422 protocol. Serial to Ethernet converters enable the camera 
to communicate with other components of the Camera Control System.

The Camera Control System uses the Comtrol DeviceMaster RTS 4-Port DB9 four-port device server as a serial to 
Ethernet converter. The Comtrol unit is available from Ross Video.

The number of Comtrol units required depends on the number of cameras to be controlled, and their locations. Each 
Comtrol unit can host up to four cameras. Comtrol units are typically located close to the cameras, to reduce cable 
runs.

For example, if there are a total of six cameras split evenly between two studios, you would typically install one 
Comtrol unit in each studio, as shown in the “System Architecture Diagram” on page 2–2.

Serial Cables Between Cameras and Comtrol Units

Each camera connects to a Comtrol unit through a serial cable assembly. Because the required length of the cable 
assembly varies for each camera installation, each cable assembly is custom-made.

For each camera, you can make your own cable assembly end-to-end, or buy a set of two adapter cables from Ross 
Video and then make a custom-length cable to span between them (Figure 2.2).

Figure 2.2  - Serial Cable Assembly Made With Ross Adapter Cables

Note: If you use a set of two Ross Video adapter cables, you must use both cable adapters. You cannot use only the 
cable adapter that attaches to the camera, because the cable pinouts will not be correct.

Tip: For the custom-length cable that spans between the two adapter cables, only pins 1 to 5 are used.

To manufacture an end-to-end cable assembly without Ross Video adapter cables, the pinout information is as 
follows:

Table 2.1  - Pinouts for Custom End-to-End Serial Cable Assembly

Camera End

Female DB9

Comtrol End

Male DB15

(high density)

Pin 4 Pin 2

Pin 5 Pin 3

Pin 10 Pin 7
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IMPORTANT: When using robotic camera systems, make sure all cable assemblies are long enough to 
accommodate the full range of camera motion.

Proxy Server Computer

If your system includes multiple camera control workstations, the camera control computers are set up in a 
client/server topology. On the proxy server, DashBoard is configured to be the 'proxy server' instance. On each 
camera control computer, DashBoard is configured to be a client of the proxy server instance.

The proxy server communicates with the cameras. All camera control requests from camera control computers are 
handled by the proxy server.

Because the proxy server must remain on at all times, we recommend you use a server-grade computer installed in 
a rack room. Alternatively, you can designate one of the camera control computers to act as the proxy server.

You can purchase a server from Ross Video. Alternatively, you can use any computer that meets the Windows 
system requirements for installing DashBoard. To view the DashBoard system requirements, download the 
DashBoard User Guide at http://www.rossvideo.com/control-systems/dashboard/index.html.

Network Configuration

Components of the Panasonic Camera Control System communicate over an Ethernet network. You can use a 
dedicated network switch, or an existing network.

The following components require Ethernet network connections:

• Each Camera Control Computer

• Each Comtrol unit

• The proxy server (only required for systems that have multiple camera control workstations)

Note: Ethernet cables between components are not included.

Pin 9 Pin 8

Pins 11, 12,13,14,15 SHELL

Table 2.1  - Pinouts for Custom End-to-End Serial Cable Assembly

Camera End

Female DB9

Comtrol End

Male DB15

(high density)

http://www.rossvideo.com/control-systems/dashboard/index.html
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Hardware and Software Checklist

The tables in this section list everything you need to purchase for your system. You can use them as checklists when 
determining what you need.

Table 2.2   - Camera Control Workstation Equipment and Software

Table 2.3  - Studio and Network Equipment

Quantity Item Source Notes / Requirements

Camera Control 
Computer

Must include monitor, 
keyboard, and mouse.

One computer per workstation.

Ross Video sells an all-in-one computer for this 
purpose.

Computers must meet Windows system 
requirements for DashBoard installation.

Computers require power supply outlets.

Panasonic camera 
control license

Ross Video One license per camera control workstation.

Camera Paint Box Ross Video Maximum one per workstation. Optional accessory.

The Camera Paint Box requires a power supply 
outlet.

Camera video monitor 
and 
waveform/vectorscope

Other Minimum one per workstation.

Can have multiple monitors for side-by-side 
comparison of camera outputs.

May also require waveform/vectorscope for 
fine-tuning camera output.

Monitors and waveform/vectorscopes require 
power supply outlets.

Routing and switching 
equipment for camera 
video monitor(s)

Must include video 
cabling between cameras 
and router, and between 
router and monitor(s).

Independent of Camera Control System.

Typically, an existing video router is used.

Ross Video can provide video routing solutions.

Routing equipment requires power supply outlets.

Quantity Item

Source

(Ross or Other) Notes

Panasonic camera Other Contact Ross Video for information about 
which Panasonic cameras are supported.

Each camera requires a power supply outlet.

Serial to Ethernet 
converter

Comtrol DeviceMaster 
RTS 4-Port DB9 
four-port device server

Ross Video Each Comtrol unit can host up to four 
cameras.

Each Comtrol unit requires a power supply 
outlet.
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Serial cable assembly One per camera.

Each serial cable assembly is custom-made, 
and connects a camera to a Comtrol unit.

For more information, see “Serial Cables 
Between Cameras and Comtrol Units” on 
page 2–4.

Proxy server for camera 
control

Required if your system has multiple camera 
control workstations.

Ross Video sells servers for this purpose

Server must meet Windows system 
requirements for DashBoard installation.

Server requires a power supply outlet.

Panasonic camera 
control license for proxy 
server computer

Ross Video License fees are based on the number of 
camera control workstations in your system.

If your system has a proxy server running on a 
separate computer (as opposed to running on a 
camera control computer), the license for the 
proxy server computer is provided free of 
charge.

Network Switch Other Can use dedicated network switch, or an 
existing LAN.

Ethernet network cables Other The following require network connections:

• Each Camera Control Computer

• Each Comtrol Unit

• Proxy server (if equipped)

Quantity Item

Source

(Ross or Other) Notes
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Installing the System
This section describes how to install and configure a standalone Panasonic Camera Control System.

Before you install the system, you need to plan the installation. For more information, see “System Overview and 
Planning” on page 2–1.

9.9 (or higher)Perform the installation procedures in the following order:

1. “Establish a Network” on page 3–1

2. “Install Camera Control Computers” on page 3–1

3. “Install Camera Paint Boxes” on page 3–2

4. “Install the Proxy Server” on page 3–2

5. “Install and Configure Panasonic Cameras” on page 3–2

6. “Install Serial to Ethernet Converters (Comtrol Units)” on page 3–3

7. “Configure Serial to Ethernet Converters (Comtrol Units)” on page 3–4

8. “Install DashBoard Software on All Computers” on page 3–5

9. “Configure the First Computer” on page 3–5

10. “Configure Additional Computers” on page 3–9

11. “Configure the Camera Paint Box Connection” on page 3–10

12. “Install the Camera Video Monitor(s) and Routing/Switching Equipment” on page 3–11

Establish a Network

The Panasonic Camera Control System can use a dedicated network switch, or use an existing LAN.

To set up a dedicated network switch:

1. Install the network switch in an appropriate location.

2. Connect the power supply for the switch.

3. Turn on the switch.

Install Camera Control Computers

Each workstation includes one camera control computer. This section describes how to install a camera control 
computer provided by Ross Video. If your computer is not provided by Ross Video, the steps may vary somewhat.

To install a Camera Control Computer and Peripherals:

1. Position the camera control computer in the camera control workstation location.

Ensure that the touch-screen monitor is within easy reach of the operator. Ensure that the optical drive, 
accessory ports, and buttons on the right and left edges of the computer are accessible.

2. Position the keyboard and mouse within easy reach of the operator, and then plug them into the connection 
panel on the back of the computer.

3. Plug one end of an Ethernet cable into the connection panel on the back of the computer. Connect the other end 
to the network.

4. Connect the power cable to the computer, and to a suitable power outlet.

5. Configure the networking parameters (IP address, subnet mask, and gateway).
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Install Camera Paint Boxes

The Camera Paint Box is an optional accessory. Each work station may or may not include a Camera Paint Box.

To install a Camera Paint Box:

1. Position the Camera Paint Box in the camera control workstation location.

Ensure that the Camera Paint Box is within easy reach of the operator.

The Camera Paint Box can sit on a flat surface, or occupy 1RU in a standard 19” component rack.

2. Plug one end of the provided USB cable into the Camera Paint Box. Plug the other end into a USB connector 
on the back of the camera control computer.

3. Plug the power cable into the Camera Paint Box, and into a suitable power outlet.

On the front of the Camera Paint Box, a green LED indicates that the unit is powered.

Install the Proxy Server

This section applies only if your system has multiple camera control workstations.

The proxy server communicates with the cameras on behalf of the camera control computers. It must always be 
running, and must be on the same network as the other components of the system.

This section describe how to set up a proxy server computer provided by Ross Video. If your computer is not 
provided by Ross Video, the steps may vary somewhat.

The operator does not need access to the proxy server. The server can be installed in a rack room. It does not need a 
dedicated keyboard and mouse. You can use a KVM, or use Windows Remote Desktop to interact with the server.

To install the Proxy Server:

1. Position and install the server in a standard 19” component rack.

2. Connect the power cable to the computer, and to a suitable power outlet.

3. Plug one end of an Ethernet cable into the server. Connect the other end to the network.

4. Turn on the server.

5. Configure the networking parameters (IP address, subnet mask, and gateway).

Install and Configure Panasonic Cameras

This section describes how to install Panasonic cameras, and how to set their communication protocol to RS-422.

To install and configure a camera:

1. Position and mount the camera.

2. On the camera, find the IRIS switch and set it to the automatic (A) position.

3. Plug the camera power supply unit into the camera and to a suitable power outlet.

4. Plug the video output from the camera into a video monitor. Turn on the video monitor so you see the camera 
output.

5. On the back of the camera, press and hold the MENU button until the USER MENU appears on the monitor.

6. Using the DOWN and UP buttons, navigate to the SETTING option, and then press the ENTER button.

The SETTING menu appears.

7. On the SETTING menu, navigate to the PROTOCOL option and then press the ENTER button.

The PROTOCOL menu appears.
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8. On the PROTOCOL menu, navigate to the PROTOCOL option and then press the ENTER button.

The PROTOCOL value flashes.

9. Using the DOWN and UP buttons, set the PROTOCOL value to 3, and then press the ENTER button.

The PROTOCOL value stops flashing.

10. Disconnect camera power to turn off the camera.

The communication protocol is set and will be applied when the camera is turned on again.

11. Disconnect the video output cable from the camera.

Install Serial to Ethernet Converters (Comtrol Units)

Supported Panasonic cameras communicate over RS-422 protocol. Serial to Ethernet converters enable the camera 
to communicate with other components of the Camera Control System.

The Camera Control System uses the Comtrol DeviceMaster RTS 4-Port DB9 four-port device server as a serial to 
Ethernet converter. The Comtrol unit is available from Ross Video.

Each Comtrol unit can host up to four cameras.

To install a Comtrol unit:

1. Position and mount each Comtrol unit such that:

• Serial control cables can be run between the Comtrol unit and the cameras it hosts.

• An Ethernet cable can be run from the Comtrol unit to the network.

• A suitable power outlet is available for the Comtrol unit.

• The Comtrol unit is close to the cameras it hosts, to reduce cable runs.

2. Connect a serial cable assembly from each camera to a Comtrol unit.

For more information about making custom serial cable assemblies, see “Serial Cables Between Cameras 
and Comtrol Units” on page 2–4.

Note which camera is plugged into which Comtrol port.

Tip: Ports are labeled RX1/TX1 through RX4/TX4.

3. Connect an Ethernet cable between the network and the left Ethernet connector (labeled UP) on the Comtrol 
unit.

4. Plug the power supply cable into the Comtrol unit, and into a suitable power outlet.
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Configure Serial to Ethernet Converters (Comtrol Units)

This section describes how to configure the serial-to-Ethernet converter (Comtrol unit) to communicate with 
cameras and other devices in the system.

Note: To perform the steps in this section, you need to have good working knowledge of basic computer 
networking procedures.

The steps in this section require a Windows laptop computer and a short Ethernet cable.

To configure a Comtrol unit:

1. On the Comtrol unit, disconnect the network Ethernet cable from the left Ethernet connector (labeled UP).

2. Connect the short Ethernet cable between the laptop computer and the left Ethernet connector (labeled UP) on 
the Comtrol unit.

3. Configure the IP address of the Windows laptop computer so it can communicate with the Comtrol unit.

The default Comtrol network settings are as follows:

• IP Address: 192.168.250.250

• Subnet mask: 255.255.0.0

• Gateway address: 192.168.250.1

4. Connect power to the Comtrol unit. 

The unit initializes.

5. On the Windows laptop computer, in a Web browser, navigate to the IP address of the Comtrol unit 
(http://192.168.250.250).

The Comtrol configuration page appears, showing four columns of configuration settings; one for each port.

6. For each port to which a camera is connected, do the following

a. Click the numbered Port link at the top of the column.

The Edit Port Configuration page appears.

b. In the Serial Configuration area, set Mode to RS-422.

c. Set the Baud rate to 9600.

d. Set Parity to None, set Data Bits to 8, and set Stop Bits to 1.

e. Set Flow to None.

f. Set DTR and RTS both to OFF.

g. In the TCP Connection Configuration area, select Enable and Listen.

h. Set the Listen Port to a unique port number.

This value is arbitrary. Note which port number you assign to which camera.

i. Set the Connect To IP address to 0.0.0.0.

j. Set the To Port value to 0.

k. Set the From Port value to 0.

l. For Connect On settings, select Always only.

m. For Disconnect On settings, ensure no options are selected.

n. Tap Save.

The Configuration Updated message appears.

o. Tap OK.
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7. In the Server Configuration area, tap Configure Network.

8. Set IP Configuration to Use static configuration below:

9. Set the IP Address, Netmask, and Gateway for the Comtrol unit.

The IP address will be used to connect to cameras from DashBoard.

10. Tap Save.

The Configuration Updated message appears, along with notification that changes to the IP address will not 
take effect until the DeviceMaster unit is rebooted.

11. Tap OK.

12. Tap Reboot.

A confirmation message asks whether you want to reboot.

13. Tap Yes: Reboot.

The Comtrol unit reboots.

14. For each camera connected to the Comtrol unit, make a note of its IP address and port. The IP address is the IP 
address of the Comtrol unit. The port is the port you assigned for the camera. This information is required to 
add the cameras to DashBoard later.

15. Disconnect the laptop from the Comtrol unit, and reconnect the network Ethernet cable to the left Ethernet 
connector (labeled UP) on the Comtrol unit.

Install DashBoard Software on All Computers

Install the latest version of DashBoard (v8.1.1 or higher) on each Camera Control Computer and on the proxy 
server (if present).

DashBoard and the DashBoard User Guide are available as free downloads from Ross Video. The DashBoard User 
Guide contains instructions for installing DashBoard. Both are available at the following location:

http://www.rossvideo.com/control-systems/dashboard/index.html.

Configure the First Computer

The steps for configuring the first computer in the Camera Control System are different than the steps for 
subsequent computers:

• If your system includes only one camera control workstation, the camera control computer is the first (and only) 
computer.

• If your system includes multiple camera control workstations, the proxy server is the first computer.

DashBoard is free, but use of the Camera Control System requires one license per computer. During the 
configuration process, DashBoard provides a Request Code and requires a License Key in response. The License 
Key can be obtained only by relaying the Request Code to Ross Video Technical Support. The License Key cannot 
be obtained in advance because it is a response to the unique Request Code generated by DashBoard.

Note: To perform the steps in this section, you need to have good working knowledge of basic computer 
networking procedures.

To configure the computer, you configure network settings, then add all cameras in the system, one at a time. If the 
computer is a proxy server, you also share the cameras so that camera control computers can access them.

To configure network settings:

1. Configure the network settings on the computer so it can communicate with the Comtrol unit(s).

If this computer is the proxy server, note its IP address.

http://www.rossvideo.com/control-systems/dashboard/index.html
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To add a camera:

1. On the first computer, open DashBoard.

2. From the File menu, tap New, and then tap Other.

The New dialog box appears.

3. Expand the Camera Control node, tap Panasonic Camera, and then tap Next.

The New Ross Video Panasonic Camera Connection dialog appears.

4. In the IP Address box, type the IP address of the Comtrol unit that hosts the camera you want to add.

5. In the Slot box, specify a slot number for the camera. Valid slot numbers start at 1.

Tip: In the Camera Control Panel, the order of camera selection buttons is determined by slot number, starting 
with the lowest number at the top.

 In the Port box, type the port number for the camera you want to add.
Note: When adding a Panasonic AW-UE150 PTZ camera, for DashBoard v9.8 or higher, a Port box appears. 
The default port is 80. Refer to (Figure 1).

Figure 1 - Connecting a Panasonic AW-UE150 PTZ camera in DashBoard

6. Tap the Finish button.

7. Integrating a third-party camera with DashBoard necessitates license activation. DashBoard supports two 
licensing options: Software-Based Licensing and Ross Key Based Licensing.

Software-based licensing involves connection of DashBoard to the Ross activation server either directly or via 
a Ross Product Manager licensing server on prem. To use software-based licensing, you will need a product 
key provided by Ross.

Ross Key Based Licensing is a fixed license tied to your hardware. During the licensing process you will need 
to send a key code to Ross technical support who will return a license key for you to enter into DashBoard.

For more information, refer to the DashBoard User Guide 8351DR-004-XX.

Note: Product key packs do not require a hardware request code but does require an RPM sever or access to the 
Activation server.

For activating DashBoard licensed features, refer to the following procedures:

To update DashBoard licensed features (Software Based Licensing method)
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a. From the main toolbar, select Window > Preferences. Refer to Figure 2.

Figure 2 - DashBoard Licensed Features - Software Based Licensing tab

b. The Preferences dialog box opens.

c. From the Preferences dialog box, select Licensed Features.

d. In the Licensed Features dialog box, ensure the Software Based License tab is selected.

e. Select the Server type that you are using to provide licensing.

f. If you are using the Ross Platform Manager server type, enter the Host Name and Port of the server and 
whether to Use HTTPS connection. 
Note: Select Apply to save your server settings.
Note: Use the Test Connection button to confirm a successful connection if necessary.

g. Once connection to the server is established, select Add and enter the product key provided to you.
If successful, the feature you added will appear in the Licensed Features table.
Note: Select Apply to confirm your changes.
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To update DashBoard licensed features (Ross Keys Based Licensing method)
For obtaining and entering a Ross licensing key code, complete the following:

a. From the main toolbar, select Window > Preferences. Refer to Figure 3.

Figure 3 - DashBoard Licensed Features - Ross Key Based Licensing tab

b. The Preferences dialog box opens.

c. From the Preferences dialog box, select Licensed Features.

d. In the Licensed Features dialog box, ensure the Ross Key Based License tab is selected.

e. From either the Active or Available subfolder, select the feature you want to update.

f. To obtain a Ross License Key by completing the following:

i.    Click Install/Update License.

ii.   The Enter License Key dialog box opens. Refer to Figure 4.

Figure 4 - DashBoard Licensed Features - Enter License Key

iii.    Select Copy to Clipboard to copy your request code.

iv.   Paste the request code into an e-mail to Ross Video (techsupport@rossvideo.com), requesting a 
corresponding license key. Be sure to include the original Ross Video sales order number. 
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CAUTION: Do not close the Enter License Key dialog box until you receive and apply an activation code from 
Ross Video. If you leave the Enter License Key dialog box, the activation code you receive will not work. It is 
valid only for the session during which it was generated.

v.     When you receive the license key via email, copy and paste it into the License Key box, and then tap Install.

vi.   The selected feature updates and the most current data is displayed in the License Details.

8. If the camera is ceiling-mounted (inverted), we recommend you turn On the Image Flip and Image Mirror 
options (also known as Ceiling Mount for some cameras) before you create any presets. Changing these 
settings after presets exist renders the presets useless.
The Image Flip and Image Mirror options are available in the PTZ Camera Control plugin at Config > 
Camera > Camera Options.

Configure Additional Computers

This section applies only if your system has multiple camera control workstations.

DashBoard is free, but use of the Camera Control System requires one license per computer. During the 
configuration process, DashBoard provides a Request Code and requires a License Key in response. The license 
key can be obtained only by relaying the Request Code to Ross Video Technical Support. The License Key cannot 
be obtained in advance because it is a response to the unique Request Code generated by DashBoard.

Note: To perform the steps in this section, you need to have good working knowledge of basic computer 
networking procedures.

To configure additional computers:

1. Configure the network settings on the computer so it can communicate with the Comtrol unit(s).

2. Open DashBoard.

3. From the File menu, tap New, and then tap New TCP/IP DashBoard Connect or openGear Device.

The TCP/IP DashBoard Connect/openGear Device dialog box appears.

4. In the IP Address box, type the IP address of the proxy server.

5. In the Display Name box, type a name for the camera node, as you want it to appear in the DashBoard 
component tree.

6. Select the JSON protocol.

7. In the Port box, type 5254.

8. Tap Finish.

9. In the DashBoard Component Tree, expand the Panasonic Cameras node.

10. Expand the Slot node for the camera you just added.

11. Double-tap Remote Control.

12. If the Camera Control Panel appears, go to Step 18 on page 3-10.

13. In the Enter License Key interface, tap Copy to Clipboard.

The request code is copied to the clipboard.

14. Paste the request code into an e-mail to Ross Video (techsupport@rossvideo.com), requesting a corresponding 
license key. Be sure to include the original Ross Video sales order number.

IMPORTANT: Do not do anything with the computer until you receive a license key from Ross Video. If you 
leave the Enter License Key page, the license key you receive will not work. It is valid only for the session 
during which it was generated.

15. When you receive the license key, copy it and paste it into the License Key box, and then tap Install.

mailto:techsupport@rossvideo.com
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The License Installed message appears. Tap OK.

16. In DashBoard, close the Panasonic Cameras - Slot x tab.

17. In the Component Tree, double-tap Remote Control.

The Camera Control Panel appears.

18.  In the camera selection area at the top of the panel, tap the camera name.

If the camera initializes and connects, it has been successfully added and can be controlled.

Configure the Camera Paint Box Connection

Each camera paint box is connected to a camera control computer via a USB cable. You must configure the 
computer to interact with the Camera Paint Box.

DashBoard communicates with the Camera Paint Box through a service called the bridge server. To establish 
communication with the Camera Paint Box, you must:

1. Install the bridge server software

2. Add and configure a DashBoard gateway for the Camera Paint Box

To install the bridge server software:

1. Obtain the Bridge Server software zip file from Ross Video, and save it on the camera control computer.

2. Unzip the file to C:\Ross.

3. Open a command prompt window as Administrator, and change directory to the location where you unzipped 
the file, for example:

cd "C:\Ross\Bridge Server 4.5.0.4093"

4. Type the command to install the ManagedServicesHost.exe file and then press Enter. An example of the 
command is as follows:

C:\> "Ross\Bridge Server 4.5.0.4093\ManagedServicesHost.exe" -install

5. Press Enter.

The Bridge Server software is installed. A message in the command prompt window appears when the 
installation is complete.

6. Close the command prompt window.

7. In a web browser, navigate to the Bridge Server configuration page at localhost:3000.

8. If the PaintBox Bridge service is not running, tap Start.

Tip: From the configuration page, you can start or stop the server. Alternatively, you can start or stop the 
Bridge Service Host from the Services tab in Windows Task Manager.

To add and configure a DashBoard gateway for the Camera Paint Box

1. In DashBoard, from the File menu, tap New, and then tap TCP/IP DashBoard Connect or openGear Device.

The New TCP openGear Frame Connection dialog box appears.

2. In the IP Address box, type the IP address of the computer, or type localhost.

3. In the Display Name box, type a name for the node as you want it to appear in the DashBoard component tree, 
for example, Robotics DashBoard Gateway.

4. Select the JSON protocol.
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5. In the Port box, type 5257.

6. Select the Remember connection settings for this frame check box.

7. Tap Finish.

A new gateway node with the name you specified appears in the DashBoard component tree.

Tip: After you complete this procedure, you can expand the gateway node and double-tap Station 1 to open an 
interface that displays real-time data received from the Camera Paint Box.

8. In the DashBoard component tree, expand the DashBoard Services node.

9. Tap Device Class Mappings.

10. For each Class, in the Selected Device list, select the only available option in the list.

11. In the DashBoard component tree, tap Selector UI Mappings.

12. Set the Autowire Follows UI setting to ON.

Install the Camera Video Monitor(s) and Routing/Switching Equipment

Each workstation requires at least one video monitor to view camera output. The monitor enables you to see 
on-screen camera configuration menus and monitor the effect of iris and paint adjustments as you make them. 
Sometimes two monitors are used, to compare video output of two cameras side-by-side.

Video routing/switching equipment is required to select the video. Ideally, the camera control operator should be 
able to switch the video from the camera control workstation.

Note: The camera video monitor and routing equipment operate independent of the Camera Control System. The 
Camera Control Panel and Camera Paint Boxdo not select video to be displayed on the camera video monitor.

When adjusting paint controls, technicians often use a waveform/vectorscope to fine-tune the properties of the 
camera output. The Camera Control Panel enables you to access the camera’s color bars output for calibration 
purposes.

The camera video monitor, video routing equipment, and waveform/vectorscope are not included as part of the 
Panasonic Camera Control System.

To install the Camera Video Monitor(s) and Video Routing/Switching Equipment

1. Install the Video Routing / Switching Equipment.

2. Install the video monitor(s) in the camera control workstation(s).

3. Connect video cables between the camera video monitors and outputs on the routing/switching equipment.

4. Connect video cables from each camera to an input on the routing/switching equipment.

5. Configure the video routing/switching equipment so it is possible to route video from each camera to each 
camera video monitor.
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